Advantage Gold™

QUICK START GUIDE
INSTALLATION and SETUP
1.
Install Advantage Gold on your computer. Here is a direct link to
the Advantage Gold install file on our web site. By default, it should install
to “C:\Program Files\SmartLuck\agold” folder. We don't recommend
changing the folder unless you have a reason and are knowledgeable
enough to deal with the changed folder. You can install the program in
Demo Mode to use a limited version for free. To access the full version, you
will need the registered name, serial number, and installation key.
2.
Open the Advantage Gold program icon (a yellow A* symbol)
created by the install program on your desktop. The program will open to
the main history view screen.
3.
Get some History files: The first step is to download history files
before you start using Advantage Gold. Under the top menu, choose Help
→ Run Lottery Updater to run Lottery Updater and download your game
files. You can run this program any time, but our updates are usually done
Monday-Friday around noon. Close Lottery Updater when done. You can
also access Lottery Updater by clicking the icon from the Select History
screen.

SELECTING YOUR HISTORY FILE
1. Choose your game. From the drop
down in the top right of Advantage Gold,
Select History Drop Down Selector
choose the history file you want to use.
From the selection screen, you will see a list of all the files you downloaded
with Lottery Updater. Quickly find the lottery you want by typing the state
letters of that lottery. For example, type fl5 to get the Florida pick-5 lottery
or nyk to get New York Keno game. Each letter you type will move the light
bar closer to what you're looking for. Press ENTER when you find the
game you want. Or you can choose a file to work with by double

clicking, clicking a file and choosing the Select button, or right clicking a
file and choosing Open. If the list shows only Pennsylvania dead lotto,
then you missed step 3 step above, or Advantage Gold is not in the folder
expected by Lottery Updater.
2. Favorites. You can also save a file as a favorite by clicking the Add to
Favorites button. Once you have favorites added, they will be listed as
small buttons at the top of this screen so you can find them more easily in
the future. Right-click a favorite button to remove it or rename the button.

EDITING THE HISTORY
Lottery Updater will usually get files current as of the last business day
(based on USA Eastern time zone Gmt-5). If you are using a lottery that
draws more frequently, you may need to key in the weekend's winning
numbers yourself to get the history current before using the charts. This
was designed to be as easy as we could see how to make it, so that it
would be easy for us to use as well.
1. Add new drawing.
•
Lottery Website: To find the lottery's official game results in
order to update with a new drawing, click the lightning bolt button. This
will take you to the website we have saved for this game.
• When viewing your selected game's history from the main menu
(Modify History screen), press ENTER to enter edit mode and a new
drawing line will appear at the end of the history file. It will show the
projected date based on the drawing days used the previous week. (If
the date is wrong because of a missed drawing or a new drawing date,
use the left arrow key and you can correct the date by using the
up/down arrow keys or just type the corrected date as a 6-digit date.
Press ENTER (or tab) if you changed the date to get back to the
position of the first number of the drawing.
• Type in the winning numbers using two digits for each number. The
program will automatically step through each entry inserting the dashes
between numbers.
•
Save: When all numbers are entered, the program will drop
down to the location of the next drawing. Press ENTER again

or hit the Cancel button if you are finished. Then hit the Save button or
File → Save.
2. Insert a drawing. If you need to add a missed drawing in between
results, you can right-click and choose Insert → Insert Entire Drawing.
Note that you can also add a drawing to the end with an older date, and it
will automatically sort by date once you save the file.
3. Edit a drawing. To edit an existing drawing, double click on the
drawing to enter edit mode and update the numbers by typing over them
or press the Clear button and then type the correct numbers. Note that
only the Date and Numbers columns can be edited. The Day column will
automatically display based on the date, and the other columns are stats
that are automatically created based on each drawing.
4.
Edit file properties. To edit the properties of a file such as the
location, name, dates of ranges and number fields, click the hammer
Properties button. Note that edits made to the properties will be
overwritten if you download our history file updates.

USING CHARTS – TOP HIGHLIGHTS
GENERAL NOTES
• Any examples shown in this document are using the Pennsylvania
Dead Lotto file. To follow along, please select this game.
•

Select or change charts: Once you have selected your
history file, you are ready to go. Use the Pick Chart drop
down menu, the number/letter shortcut keys from Advantage Plus, or
the Charts link on the main top menu to select your chart to view.
From inside any chart, use the chart selector button to close the chart
and go back to the main screen with the chart menu open so you can
choose a new chart.
• Column Sorting: Many charts will sort the columns shown by
highlighting the column header. For most charts, the column that is
currently being sorted is highlighted in yellow. Click a column header to

sort the data by that column in ascneding order. Click again to sort in
descending order.
•

Print using F2, the small printer button, or File → Print.

•

Change Range using the Range button. Range specifies which
drawings you are including in the data of the chart. The
program default is to use the entire game file, or the pre-locked range
which starts at the first drawing of the most recent number field of the
game. You can also use the small left and right arrow buttons at the
bottom right of a chart window to quickly add or remove a drawing from
the range. The H button will reset the range.
The
number to the left of the arrows displays how
many
Smart Picks the chart selected.
• Back: To go back or close a chart, click the x in the top right, or press
the ESC key.
• End/Home: You can use the End and Home key to jump to the first
and last row in a chart instead of scrolling.
•

Bonus number options: If the game has a bonus or
Powerball number, there will be B-, B+, and B* icons at
the top left of each chart. Use these to display the chart with and
without the bonus, or for only the bonus number.
•

Graph display options: For charts with
graphs, you can click the different graph icons
to display the chart in a different way: line chart, bar chart, area chart,
points with best fit line, or points with best fit curve.
SMART PICKS®
Seven of the Charts in Advantage Gold, Charts 3, 4, 5, 6, 7, C and
D, have Gail's rules for picking numbers built into the chart. The selected
numbers, the Smart Picks, are marked with '*' (asterisk) next to the lotto
number. Advantage Gold contains a Scoreboard (Chart V) where each
chart's Smart Picks are recorded. When you update the history files, that

scoreboard is cleared. Then when you run each chart, a column of the
Scoreboard is filled in. As long as you have at least one chart run, you can
go to the Smart Picks screen, Chart W, and tell it how many numbers you
want. It will choose the numbers picked by the most charts that you ran.
The Number Group Test chart to the right of Chart W will show you how
the selected set of Smart Pick numbers would have performed in past
drawings for your game. It tells you the number of drawings and
percentage of drawings that these numbers would have matched 1 or more
winning numbers in the past.
If you want to run all the Smart Pick charts quickly and then get
the best numbers based on that, from the Advantage Gold Main Menu,
press 3-ESC, 4-ESC, 5-ESC, 6-ESC, 7-ESC, C-ESC, D-ESC, then press
W and type in the number of Smart Picks you want, ex. 18 and press
ENTER. The top 18 numbers would show on the screen.
That said, we don't recommend the Smart Picks, unless you
just don't have the time to study the charts. Analyzing the charts
can normally do better.

Chart 3 – Quick Stats™
Press 3 or select the 3. Quick Stats chart from the menu to bring
up Chart 3. This shows statistics about the past performance of each
number. Notice the Smart Pick asterisks in the first column on the left on
some of the numbers, 03*, 08*, 10*, 14* and 15* are all starred as smart
picks.
The Range of Drawings that are included in the chart is shown at
the bottom center of each chart next to the range button, “Range: 1 to 621
(04-16-02- 2/15/08)”, in this example.
Click the Hits column to sort by the total hits. This will show the top
number as 26 with 126 hits. Number 36 will be highlighted and it shows a
total hits of 82 hits. So the top hitting number here, as in most lotteries,
has hit more than a third more often than the least hitting number.
MOST IMPORTANT POINT ABOUT CHART 3: In all lotteries, the
position of numbers in this chart tend to remain close to the same rank –
especially the top and bottom numbers. In the Florida Pick 6 Lottery, for
example, the top hitting number, 28, was the top hitting number for more
than 600 drawings. If you look at the entire 621 games of the Pennsylvania
dead lottery, it will show that 26 was the top number for 319 drawings.

That doesn't mean the top numbers will hit in every drawing or that you
should include them in every drawing. But you should strongly consider the
top 10 numbers in each drawing as candidates, and definitely avoid the
bottom few numbers, unless you have a good reason to use them.
Rollback Drawings + and You can use the new arrow buttons at the bottom of each chart to
quickly change the range. Hit the back arrow button or the Minus key on
the keyboard, '-' to roll back the history by one drawing – i.e. the last
drawing is removed from consideration. The range shown will change to
“Games 1 to 620.” Notice that the numbers +02*, +04* and +06 all have
the + to their left. This shows the numbers that were drawn on the
drawing just past the last used by the chart. It's a peek ahead. On this
page, the numbers with a plus and an asterisk are Smart Picks that were
correct, +02*, and +04*. Numbers with the asterisk but without the plus
are Smart Pick numbers that did not hit, 10*, 14* and 15*. Numbers
without an asterisk but with the plus sign are numbers that were missed by
the Smart Picks, +06.
Range Settings
If you look at samples of 10,000 coin tosses, you would expect the
results to be very close to 50% in just about every sample. If you look at
just 100 tosses, you would see 40%-60%, 30%-70% and many other
arrangements of the results. The 50%-50% split would be no more likely
that the others. This would give you a current trend to help in predicting
the next results. Lotteries are the same. The results are just spread over
more points – one for each number. If you include enough drawings, there
would be little difference in the statistics for any numbers. It would hide
the most recent trends making the information just about useless.
At the bottom of most Advantage Gold charts, is a Range Function
that allows you to change the drawings that are included in the calculations
for the chart. This does not affect the contents of the file, just what is
visible to the calculations.
If your history contains much more than about 500 drawings,
especially for pick-5 lotteries, you can change it to use only the most recent
500 drawings. This is recommended for most charts – especially pick-5
lotteries.
To change the range, click the Range button
or the text that

displays the range. The Set Range screen will pop up. To change the range
to use only the last 500 drawings, click the checkbox next to Use FIXED
range of and type 500 in the box. Click the OK button. The chart will now
be based on only the most recent 500 drawings. The Range message will
show Games 122 to 621. If you press the back button or '-' key now, the
range will change to Games 121 to 620, i.e. it will rollback the starting and
ending positions, keeping the 500 game range. You can also use the Set
Range screen to specify any starting or ending draw number or date. To
keep the setting, hit the checkbox next to Save Starting Draw in file.
Press the x in the corner or ESC key to close the chart and get back to the
Main Menu, or press the chart selection button
to immediately go
to the chart selector menu.

Chart 4 – Drawings Since Hit Chart™
Select 4. Drawings Since Hit from the chart menu or Press 4 to get
the Drawings Since Hit chart, then click the tab for 4a. Abbreviated
Chart or press A. This will show the results of the most recent 73
drawings on a single page if you print this. It is most useful in determining
recent activity of a number at a glance. Or view 4b to see the numeric
version of this chart.
On the chart, each column down the page is a drawing with the most
recent drawing on the right. The numbers at the top are every fifth
drawing number. The dashes are drawings in which the number on that
row did NOT hit. The x's show when the drawing did hit. If your lottery has
a bonus number, the hit in the bonus position will be shown with the letter
'a'. If the number hits as both a normal number and as a bonus number, it
will show as a 'd'. This can only happen in Powerball-type games and
really should not happen. You should turn off the Powerball in these games
by clicking the B- button in the top of the chart, or using ALT-B so that
the top right will show Bonus OFF.
Right-Click options: You may prefer to remove the horizontal lines
or grid bands from this chart for easier viewing. You can do either of these
by right-clicking and choosing the corresponding options. The right-click
menu also allows you to change the font sizes and turn on/off the Tooltip
hints (blue boxes with white text that explain what you are seeing when

you hover over a cell).
Most Important Point about Chart 4 is that you can see at a
glance the recent activity of each number. Using this along with chart 3
helps you find which of the most active numbers to play or not play and
when to play the most inactive numbers. Of course, that is not an exact
science, but it is usually more fruitful than doing nothing. You can also see
connections between numbers, like when 5 plays in one drawing and 6
plays in the next. Often, these connections seem to repeat frequently
enough that it is worth playing the next one when the first one hits, unless
it just did that the previous time.

Chart 6 – Skip and Hit Chart™
Select 6. Skip & Hit from the chart menu or Press 6 to get the Skip
and Hit chart. This chart probably looks very intimidating at first glance. It
shows in columns the number of times each number hit when it was that
many games out. For example, for Pennsylvania Dead Lottery, it shows that
the number 01 is currently out 1 game and has hit 14 times after no skips,
13 times after one skip, 5 times after 2 skips, 7 times after 3 skips, etc.
Hit the tab for 6a. Individual Number Graph or press A to see this
information as a graph for a single number. For the number 01, you can
see that this number hits much more often after itself or after skipping one
drawing.
We would recommend playing this number usually when it has just
hit or when it has skipped one drawing, but you do need to check recent
activity in chart 4A to be sure this isn't a repeat of the last action. In this
specific case, the number is currently one game out and so by itself, this
would recommend it to play. Chart 4 shows the preceding hit was 7 games
back, and so it really doesn't help, however, in chart 3, we see that this is
the second least hitting number at the very bottom of the chart. That
would overrule the chart 6 recommendation, and consequently, we would
not recommend playing number 01 in the next drawing.
Use the Up/Down arrow keys or the scrollbar to move up and
down in the numbers. This chart will often help you pick a couple of correct
numbers.
The most important thing about Skip and Hit Chart™ is what
happened in the most recent FIVE drawings, the five bars at the left of the

graph. The chart recommends playing a number when there is a spike at
the current games out for a number but also when there is a serious void
or much lower than the surrounding bars. For example, 01 shows only 6
hits at 2 games out which would be a recommendation when the number is
at that position.

Chart B – Games Out View of History™
Select B. Games Out View from the chart menu or Press B to get
the Games Out chart. This chart is a way of seeing how many games out
each number was when it hit. The intent is to see when too many numbers
are repeating, so you can eliminate or ignore all the numbers from the
most recent drawing and know when to play the numbers from the last
drawing most heavily.
One of our jackpot winners used this to play 5 small wheels, each
using one number from the last drawing as a Power Number™ (a number
repeated in each combination), and the other numbers in each wheel
contained the other numbers in that drawing, along with additional choices.
Some of the sub-charts for Chart B will reveal important information
about your lottery.
Select B4. Games Out tab or Press 4 to get the Games Out Report.
If you look at the Cumulative column, it shows for this lottery that
numbers with a games out of 0 hit 19.2% of the time, numbers with a
games out of 0 or 1 hit 33.1%, etc. In fact, over half of the winning
numbers had a games out in the 0-3 range. This means you should
normally try to play approximately half of your numbers for this game,
from numbers that are 0 to 3 games out. This varies for each lottery. Most
pick-5 games show 5 games out as the mid-point. Powerball and Mega
Millions both show 7 games out. This chart now shows a new column,
Lotto Numbers at Games Out, so you can easily make your selections.
You can also look for a bias in the games out values. Like most
biases, they don't occur frequently, or they wouldn't be called biases but
rather norms.
Skips Due Bias Tracker™ shows each games out and how many times
that games out happened in the most recent 5 drawings. What you are
looking for is a very high number of hits or a void in the number of hits, i.e.
no hits at a specific games out. The Lotto #s column is not really related to
this chart but shown so you can easily get the numbers you want to use or
avoid based on the specified games out.

Last Words
This has been a very light overview of the Advantage Gold. The four
charts above are probably the most important and easiest to understand
charts in Advantage Gold. They are probably the easiest way to start
benefiting from using the program. You can use the old Advantage Plus
manual for an overview of the other charts until we have released the
Advantage Gold help.
We recommend you go through each of the charts when you have
some time and examine them. Make a list of the charts that make most
sense to you, and skip the ones that are confusing. Come back to it a week
or so later, and it will most likely make more sense. There is a great deal of
information available in Advantage Gold, and it can be a great help in
getting the winning numbers.

More Help
We have an extensive FAQ available on the website with many of the
commonly asked questions. Please check it first to see if your question is
listed there. http://www.smartluck.com/faq/lottery-questions-answered.htm
If you have a very specific question that can be answered quickly,
you can email techhelp@smartluck.com to ask the question. Please put
“Smart Luck Tech Support question” in the subject line to get past our
spam filters.
Tech support number is 727-441-8714 and is available Monday
through Friday (except postal holidays) between the hours of 1:00 pm and
5:00 pm eastern time (gmt-5).

